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1. INTRODUCTION 
 

Overview 
 

The correlator FC is a multipurpose real-time device for auto- and cross-correlation measurements 

built on the software-configurable flex-logic integrated circuits. A capability of further software 

upgrade of hardware functions is the unique feature of the FC correlator. The FC is a suitable device for 

photon correlation spectroscopy because it has all necessary modes of operation and is a fully 

hardware standalone device. Therefore, it is possible, during accumulation of the correlation function, 

to use the computer for other purposes (e.g. temperature control). 

 

The FC has TTL input levels as standard. Both autocorrelation and cross-correlation functions can be 

measured. The living display of a probability distribution of the real input signal favors correct result 

making.  The FC provides most efficient data collection in a wide dynamic range of the input signal.  

 

 

Specifications 
 

Hardware structure Programmable flex-logic 

Processing algorithm Hardware, updated through software 

Processing 32 bits 

Input frequency 100 MHz 

Capacity of each channel (hardware) 48 bits 

Minimum sample time (true real-time operation) 10 ns 

Input signals TTL 

Operation mode Autocorrelation; cross-correlation 

Time scale Multiple-tau; linear 

Multiple-tau scale  

Number of channels 288 

Configuration 36 sections x 8 channels, factor 2 

Number of monitor channels 72 

Linear time-scale mode  

Number of channels 128 

Number of monitor channels 3 

Software dust-cutoff regime Yes 

Prescaling Not required 

Living monitor of probability distribution Hardware 

Design USB interface 

Dimensions (LxWxH) 160 x 95 x 35 mm 

Power requirements 5V x 0.2A 
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2. INSTALLATION 
 

System requirements 
 

FC correlator requires the following minimum system configuration:  

 

Microsoft Windows 2000/XP/Vista/7 

 

PC-compatible computer 

Spare USB port 

30 MB free hard disk space 

 

 

Installation of the FC software 
 

Before installing the FC correlator you need to install the FC software: 

 

1) Insert Photocor CD into the CD-ROM drive. 

 

2) Open the Software folder on the Photocor CD, double-click the FC-6.0E.exe file and follow 

the on-screen instructions to complete the installation. 

 

 

Note: You must have administrative privileges in order to install FC software on Windows 

2000/XP/Vista. 

 

Important: To run DynaLS after installation you are to have Aladdin HASP key inserted in the parallel 

or USB port of your computer. Without HASP user may run DynaLS during evaluation period with limited 

number of loadable data files. 

 

 

Installation of the FC correlator 
 

 
Rear panel of the FC correlator 

 

1) Connect the USB cable to the connector labeled USB on the rear panel of the FC correlator 

 

2) Connect the other end of the cable to the USB port on the computer 

 

 

3) Connect cables from photon counting system to inputs labeled A and В on the rear panel of the FC 

correlator (for photon counting system with single PMT module only one input A or B is connecting) 

 

4) After all cables is connected additional configuration of FC correlator are required:  

В 

 В  

А 

USB 

 В  
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- open the Device Manager: 

 

for Windows XP: 

- click the Start button 

- click the Control Panel 

- click Switch to Classic View in the upper left area of the window 

- click the System shortcut 

- switch to the Hardware tab 

- click the Device Manager button 

 

for Windows Vista/7: 

- click the Start button 

- click the Control Panel 

- click the System and Security shortcut (only for Windows 7) 

- click the Device Manager in the category Sytem 

 

 
 

- expand the Universal Serial Bus controllers list 

 

- double click the USB Serial Converter A device 
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- switch to the Advanced tab 

 

- clear the Load VCP checkbox 

 

- click OK 

 

- now you need to perform the same actions for the USB Serial Converter B device 

 

 

Note: In future if you connect the FC correlator to another USB port of the computer you will need to 

perform step 4) again. 

 

 

5) Installation of the FC correlator is completed. Now you may start working with the FC software. 
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3. DESCRIPTION OF FC PROGRAM 

 

Typical FC window 
 

A user may combine a suitable configuration of the FC windows on the screen. Example of a screen is 

shown below: 

 

 
 

There are the following types of windows: 

 

1) To display measured values: Accumulation, Reading, Count Rate Monitor, Temperature 

Monitor, File - window to show saved correlation function.   

 

2) To control correlator and some functions of the BC-1 instrument: Control window with tabs, File 

setup. 

 

3) Standard dialog boxes of Windows. 
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Accumulation window 
 

Accumulation window monitors in real time the process of accumulation of the correlation function in 

the correlator. For activation of the window Accumulation it is necessary to open menu View and 

select Accumulation. 

 

Depending on the hardware configuration of the correlator (multiple-tau or linear channel spacing) the 

correlation function shows in form a) and b) correspondingly. 

 

  
 

a)  b) 

 

 

Reading window 
 

Reading window shows the correlation function read out from the correlator to PC for fitting or 

saving.  

 

To be able to perform fitting of the accumulated correlation function you should first copy it into the 

computer memory using the Read button. It is not necessary to stop the accumulation before reading 

of the correlation function. Therefore, you can make current estimation of the particle size during the 

process of accumulation. 

 

For activation of the Reading  window, it is necessary to open the View menu and select Reading or 

simply click Read button on the toolbar. 

 

Examples of Reading  windows for multiple-tau and linear hardware configurations are shown below: 
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Count Rate Monitor window 
 

Count Rate Monitor window displays current count rate of input signals of correlator coming from 

photon counting system. 

 

Take into account that count rate of input signals will be measured, if the Count Rate Monitor 

window was open before Run of the correlator. For activation of the Count Rate Monitor window it is 

necessary to open menu View and click Count Rate Monitor. 

 

Count rate history can be saved in common file of results by clicking button Save. 

 

  
 

 

Count Rate Distribution window 
 

Count Rate Distribution window displays current differential probability distribution of input signals 

of correlator coming from photon counting system. 

 

Take into account that probability distribution of input signals will be measured, if the Count Rate 

Monitor window was open before Run of the correlator. For activation of the Count Rate 

Distribution window it is necessary to open menu View and click Count Rate Distribution. 

 

Count Rate Distribution can be saved in common file of results by clicking button Save. 
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Temperature Monitor window 
 

Temperature Monitor window display current temperature in graphical form. 

 

For activation of the window Temperature Monitor it is necessary to open menu View and select 

Temperature Monitor. 

 

 
 

 

Window for saved files 
 

Saved correlation functions can be displayed in corresponding window. This window appears after 

open of file from menu File or clicking the file open button. Name of window corresponds to name of 

open file. 
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Control window 
 

Control window is used to set parameters of experiment. 

 

For activation of the Control window, it is necessary to open the View menu and select one of the 

items in the Control menu or simply click Control button on the toolbar. 

 

 

Correlator tab 
 

Channel Spacing: 

 

Two radio buttons Channel Spacing serves to switch Multiple tau or Linear hardware configuration 

of the correlator. If Linear channel spacing is set, the correlation function is accumulated and displayed 

in the linear time-scale. If Multiple tau channel spacing is set, the correlation function is accumulated 

and displayed in the quasi-logarithmic time-scale. The change of the mode must be confirmed with 

clicking Set button. 
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Operation mode: 

 

The FC correlator has two functionally equal inputs. For autocorrelation measurements input A or B 

can be chosen in accordance with the physically used input of the correlator. For cross-correlation AB 

or BA modes are available, which corresponds to (current A  delayed B) or (current B  delayed A) 

multiplication of signals. 

 

 

Sample-time setting: 

 

This setting is active for Linear channel spacing only. Two spinner controls are used to set value of 

Sample time, one is to set mantissas, another one is to set an exponent value of Sample Time.  

 

Any changes in tab Correlator will be activated after clicking Set button. 

 

 

Constants tab 
 

The edit strings: Temperature, Viscosity, Refractive index, Wavelength and Angle allow to set, 

correspondingly, the values of temperature, viscosity, refractive index of the solvent, laser wave length 

and scattering angle. A user can choose a solvent from the Solvent list box, and Viscosity of a solvent 

will be calculated automatically according to the set temperature. The data for solvents are stored in 

text files with .cns extension. These files should be in the same directory as Photocor.exe file. 

Similar files for any solvents can be created in the same manner, if necessary. 

 

 
 

 

Experimental parameters setting: 

 

Determination of a particle size from the characteristic decay time of a measured autocorrelation 

function is based on the Stokes-Einstein formula (see p.21 of this Guide). Therefore, before data 

processing it is necessary to let the program know the values of the experiment conditions 

represented in the formula. They should be set in the Control-Constants window. It is necessary to set 

four values in this menu. They are temperature, solvent viscosity, solvent refractive index, and laser 

wavelength. 
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To free the user from the searching of solvent viscosity and refractive index for the given temperature 

and wavelength through the books and special tables, the FC software includes corresponding files for 

most widely used solvents. To use this possibility, just set the appropriate solvent in the Solvent toggle 

field of the Control-Constants window. After that, solvent viscosity and refractive index will be 

determined automatically for the preset temperature. If the solvent you are using is not in the list or if 

you prefer to set the constants manually, just set this field to "no guess".  

 

 

Solvent file creating: 

 

You can create the corresponding file yourself. The extension of the file should be .cns and the file 

should be placed in the FC software directory. It should be an ordinary text file and you can create it 

with any text editor. The format of the file is very simple. An example of a table file follows (this is just 

the file toluene.cns file): 

 
nD=1.4969 dn/dT=-5.67e-4 dn/dl=0.0 

   T    eta 

-20.0   0.989 

-10.0   0.863 

  0.0   0.770 

 10.0   0.667 

 20.0   0.584 

 30.0   0.517 

 40.0   0.469 

 60.0   0.381 

 80.0   0.318 

100.0   0.269 

 

The first string of the file contents the following values: 

nD is a value of refractive index at t=20C and for Na D-line wavelength. 

dn/dT is a refractive index temperature decrement (1 C) 

dn/dl is a refractive index wavelength decrement (1 A) 

 

All the other strings of the file are the table of temperature dependence of solvent viscosity, where T is 

temperature in Celsius and eta is viscosity in cP. The program calculates the value of a viscosity using 

the linear interpolation of the closest points of the table. The points should be ordered by the 

increasing of a temperature. The file name will be included the corresponding list of the Solvent 

toggle. 

 

Any changes in tab Constants will be activated after clicking Set button. 
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Angle tab 
 

Stepper motor driven turntable allows automatically to set a scattering angle with resolution 0.01.  

 

 
 

 

There are two modes of turntable control: 

 

Constant angle mode allows to write desirable value in Angle (degree) spinner controls. After click of 

Set button this angle will be set. 

 

Check the box Verification means that each angle will be set after verification procedure, which 

consist in turning of arm to certain angle (150°). After that the arm of turntable will go to the chosen 

angle. We recommend use this procedure seldom, for example, if scattering angle was set manually 

with existing knob in the warm gear (in this case turntable will have wrong angle scale). After single 

verification procedure, please uncheck the box Verification. 

 

Angular step mode allows to write desirable value of angle in Initial angle (degree) spinner controls 

and desirable value of angle increment in Angular step (degree) spinner controls. Each click of Set 

button will change angle from initial value with angle increment equal to chosen step. Sign – (minus) 

corresponds to decrement of angle changing with clicking of Set button. 

 

Running value of angle during turning is shown in Current angle (degree) string. 

 

Clicking of Stop button interrupt current angle operation. 
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Temperature tab 
 

Temperature tab allows to control temperature of thermostat with accuracy 0.1 C. 

 

 
 

 

There are two modes of temperature control: 

 

Constant temperature mode allows to write desirable value in Temperature spinner controls. After 

click of Run button the temperature will go this temperature. When thermostat reaches this 

temperature, it will be stabilized with accuracy 0.1 C.  

 

Temperature trend mode allows to assign desirable temperature trend in range of Initial 

temperature to Final temperature with assigned Trend.  This operation starts after click of Set 

button 

 

Running value of temperature is shown in Current temperature string. 

 

After click of Set button the temperature history will shown in Temperature monitor window during 

all time. To clear Temperature monitor window click Monitor reset button. 

 

 

Cycle tab 
 

1. Cycle tab allows to run simple cycle of measurement. The Number of runs field allows to assign 

desirable number of measurements. Waiting time between each run is written in Delay between 

runs field. Duration of each run can be assigned in frame Unit for data filtration.  
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The user has two options to assign duration of each run:  

 

2. To write desirable duration of measurement in the Duration of unit field and write 1 in the 

Number of units field. In this case duration of run will be equal to duration of unit and possible 

following data filtration will be not available.  

 

Desirable duration of measurement can be divided on many short units with duration of each unit 

written in the Duration of unit field and number of these units written in the Number of units field. 

Obtained array of correlation function can be analyzed with the Data filtration procedure. This 

procedure allows indicating the “bad” units and creating the summarized correlation function without 

these “bad” units. Data filtration procedure based on well-known fact that light scattering intensity on 

seldom large particles of contaminations (dust particles) considerably increases the average light 

scattering. Threshold for indication of the “bad” units can be assigned in Spike tolerance field. 

Correctness of the data filtration procedure can be  estimated with corresponding values shown in 

Correct units and Standard deviation fields. For the last run of the cycle the Data filtration procedure 

cab be repeated many times (Repeat data filtration button), for example, with the various spike 

tolerance values. This option is suitable for fine tuning of the data filtration procedure to find the 

optimal spike tolerance for the certain sample under investigation. 

 

 

FC title bar 
 

 
 

The title bar displays the name of the application and current active window. 

 

 

FC menu bar 
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File menu 

 

 
 

Open 

Opens an existing file. Use this command to show and fit the saved correlation function again. 

 

Save As 

Save the current file to a specified file name. 

 

Save Auto 

Save with auto-indexation. 

 

File Setup 

 

 
 

FC allows assigning file names automatically. To adjust the auto-indexation mode, follow the steps: 

 

1. Open File menu and select File setup. File report setup window will appear. 

 

2. Specify a new file name into Prefix edit string. Specify the starting index into the Index edit string. 

The index is automatically incremented after each saving of the file. The name of the file is a 

combination of a prefix and an index. 

 

3. Folder for saving is specified in Folder edit string. 
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4. Click OK. 

 

After auto-indexation has been adjusted, to save a protocol file simply open File menu and choose 

Save Auto, or click Save on the toolbar. 

 

Print 

Prints a document. 

 

Print Preview 

 

 
 

After all settings are completed, check how the data is arranged on pages before printing. For this 

purpose open File menu and select Print Preview. Your file will be displayed on the screen in the way, 

as it will be printed. Click Print in TeeChart Print Preview window. 

 

Print Setup 

 

 
 

Before printing, make sure that parameters of pages are set correctly. For this purpose open File menu 

and select Print Setup. An appropriate window will appear. 
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View menu 
 

 
 

Control 

Opens Control window in appropriate tab. 

 

Accumulation, 
Reading, 
Count Rate Monitor, 
Count Rate Distribution, 
Temperature Monitor 

Opens appropriate window. 

 

 

Tools menu 
 

 
 

Run starts the process of accumulation of the correlation function in the correlator. 

 

Stop stops the process of accumulation of the correlation function. 

  

Reset resets the correlator, i.e. sets all channels of the correlator to zero. Thus, the correlator is ready 

for a new measurement. If the data accumulated was not preliminary saved before Reset, it will be 

completely lost. 

  

Read reads out the current value of the correlation function into the computer. This correlation 

function may be fitted, saved and so forth. Reading-out of the correlation function into the computer 

does not interfere into the accumulation process. Therefore, repeated reading of the correlation 

function without stopping the process of accumulation is available. 

 

DynaLS export measured correlation function to DynaLS software. 
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Macro menu 
 

FC software supports Microsoft Visual Basic Scripting. This means you can write powerful macros that 

automate your measurements. Macro program examples can be found in Macro subdirectory of the 

main application. (C:\Program Files\FC\Macro by default) 

 

 

 
 

The FC macro functions on the Macro menu allow one to create, save, and execute a macro file. A 

macro file contains the FC macro language commands that instruct the FC correlator in accordance 

with the desirable consequence of steps. These commands can cause a message to be displayed, 

control and start sub-processes, set global variables, etc. All manual operations, which are available to 

a user, can be performed by executing the appropriate macro command or running the macro file. 

 

 

Macro functions of the FC program 
 

Note: Argument of function must be a needed variable inside the parenthesis. For functions without 

variables, argument must be (0). Argument of function can be the integer (N) or the real (R). For some 

functions the variables N or R have restricted range. 

 

  
Main functions for measurement control 

 run_cor(0) 

start the correlation function accumulation  

(the Accumulation window will be active after executing these command) 

 read_cor(0) 

read the correlation function from correlator to computer 

(the Reading window will be active after executing these command) 

  

stop_cor(0) 
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stop the correlation function accumulation 

(the Accumulation window will be active after executing these command) 

 reset_cor(0) 

reset of the correlator 

(the Accumulation window will be active after executing these command) 

 delay(N) 

delay for N seconds. If N=-1 the function will wait for run_cycle(0)command to be 

complete 

 update(0) 

updating the data on the Constants tab in the Control window 

* run_cycle(0) 

start the cycle with parameters defined on the Cycle tab in the Control window. After finish of 

the cycle procedure the Data filtration performs. Then the results are saved in the file with .txt 

extension. The file name/index defined in the File report setup window. 

After execution of this command the value of the file index in the Index field in File report setup 

window will be increased by 1. 

  

Functions for the correlator setting. 

* set_spacing(N) 

if N is 0, the linear mode set;  

if N is 1, the Multiple tau set. 

* get_st(0) 

return the current value of the Sample time 

usage example: 

set_spacing(0) 

a=get_st(0) 

MsgBox "Sample time: " & a 

* set_stm(N) 

set the the Sample time mantissa in the Correlator tab of the Control window. 

It is necessary to switch correlator to the linear mode before using this command. 

Range of N values is 1 to 99. 

* set_ste(N) 

set the Sample time order of magnitude in the Correlator tab of the Control window. 

It is necessary to switch correlator to the linear mode before using this command. 

Range of N values is -9 to -1. 

 read_st(0) 

read the SetTime.txt file from the folder where the Photocor.exe file located. At every 

command execution the next line from the SetTime.txt file will be read. Then the value from 

this string will be entered to the Sample time field on the Correlator tab in the Control window.  

usage example: see Macro\st1.phm file. 

Using this command it is impossible to read any string from the SetTime.txt file. 

Before using this command it is necessary to switch the correlator to the linear mode. 

  
Functions for the turntable control 
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* set_angle(R) 

set the angle on the turntable 

 wset_angle(N) 

the checking procedure of the angle setup finishing will be performed for the N seconds. 

If the angle setup is finished before N seconds, the next command of the macro file will be 

executed immediately 

 read_ang(0) 

read the Setangle.txt file from the folder, where the Photocor.exe file located. At every 

command execution the next line from the Setangle.txt file will be read. Then the value 

from this string will be entered to the Angle field on the Angle tab in the Control window. After 

that the angle will be set on the turntable. 

usage example: see Macro\Indik1.phm file 

Using this command impossible to read any string from the Setangle.txt file. 

  

Functions for temperature control 

 set_temp(R) 

set the temperature in the Temperature filed on the Temperature tab in the Control window. 

The process of temperature control starts immediately.  

 read_tx(0) 

read the SetTemperature.txt file from the folder where the Photocor.exe file located. 

At every command execution the next line from the SetTemperature.txt file will be read. 

Then the value from this string will be entered to the Temperature field on the Temperature tab 

in the Control window and temperature control starting. 

usage example: see Macro\termo1.phm file 

Using this command it is impossible to read any string from the SetTemperature.txt file. 

  

Main functions to work with the measurement file 

 open_win_file_conf(0) 

open the File report setup window 

 set_file_index(N)  

set the file index in the Index field in File report setup window. 

Take into account that file index while saving to the disk of the computer will be converted to 

five-digit format, i.e. if you enter 1 as file index, file name will be: Test00001.txt 

 save(0) 

save the standard file of the measurement with.txt  extension. File name and file index 

correspond to the name, assigned in the File report setup window. 

After execution of this command the value of the file index in the Index field in File report setup 

window will be increased by 1. 

Take into account that before saving the data to files it is necessary to read the correlation 

function to the computer using the following command: 
read_cor(0) 

  

 

Additional functions to work with the measurement file  
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These functions allows to create file with custom-selected data  

 save_header(0) 

Create file with .pcs extension which defined in the File report setup window. In this case the 

file index, entered in the corresponding filed in the File report setup window, will be ignored and 

the 000 always used as file index for the .pcs files. Impossible to assign a custom file index for 

the .pcs files. 

Important: this command is required to use other commands from the following list. 

 save_time(0) 

write the system time when the correlation function was red from correlator to the memory of 

computer 

 save_temp(0) 

write the latest temperature read from the temperature controller, or the Temperature string 

from Constants tab in Control window if controller are switched on.   

 save_int(0) 

write the current measured intensity and the current value of coherence to the file with .pcs 

extension. For crosscorrelation mode (AB or BA is selected) the sum of the intensities from the 

both channels will be saved. 

 save_coherence(0) 

write the current coherence to the file with .pcs extension 

 save_conc(0) 

write the value of Concentration in the File report setup window to the file with .pcs 

extension 

 save_phd(0) 

write the value of intensity monitor to the file with .pcs extension (only if intensity monitor 

switched on) 

 save_ang(0) 

write the value of the Angle from Angle tab in the Control window to the file with .pcs 

extension 

 save_end(0) 

write the end-of-line symbol to the file with .pcs extension. Used for .pcs file formatting. 

 

 

* - function in non-active, if Control window  is closed. 
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Window menu 
 

 
 

Cascade 

Arranges windows in an overlapped fashion. 

 

 

Tile Horizontally, Tile Vertically 

Arranges windows in non-overlapped tiles. 

 

 

1, 2, 3, … 

Goes to specified window. 

 

 

Help menu 
 

 
 

Help Topics 

Displays the help file. 

 

About FC 

Displays the version number of application. 

 

 

FC toolbar 
 

The toolbar is placed on the main FC window. It duplicates executing some functions of the menu bar. 

To execute a required operation or to choose any option, simply click the necessary button.  

 

 
 

 

Open opens the Open dialog box for opening a saved FC file. The button executes the same 

command as Open from the File menu. 
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Save saves the current results into a file with presetting made in the File setup window. The button 

executes the same command as Save Auto from File menu. 

 

Print opens the Report Printing window for printing a hard copy of the measurement protocol. The 

button executes the same command as Print from menu File. 

 

Run starts the process of accumulation of the correlation function in the correlator. The button 

executes the same command as Run from menu Tools. 

 

Stop stops the process of accumulation of the correlation function. The button executes the same 

command as Stop from menu Tools. 

 

Reset resets the correlator, i.e. sets all channels of the correlator to zero. Thus, the correlator is ready 

for a new measurement. If the data accumulated was not preliminary saved before Reset, it will be 

completely lost. The button executes the same command as Reset from menu Toools. 

 

Read reads out the current value of the correlation function into the computer. This correlation 

function may be fitted, saved and so forth. Reading-out of the correlation function into the computer 

does not interfere into the accumulation process. Therefore, repeated reading of the correlation 

function without stopping the process of accumulation is available. The button executes the same 

command as Read from menu Tools. 

 

DynaLS export measured correlation function to DynaLS software. 

 

Control activates Control window. The button executes the same command as Control from menu 

View. 

 

 

FC status bar 
 

The status bar of the program is placed in the bottom of the main FC window. The status bar contains 

six indicators: 

 

 
 

 

Angle – shows current angle; 

 

Temperature – shows current temperature; 

 

Intensity - shows the current average intensity during accumulation; 

 

Elapsed Time - time elapse since run; 

 

Accumulation time - shows effective time of accumulation of the correlation function;  

 

Coherence - shows a ratio of the maximum ordinate of the exponential correlation function to the 

base-line value. 
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APPENDIX A 
 

DYNAMIC LIGHT SCATTERING (PHOTON 
CORRELATION SPECTROSCOPY)  
 

Basic ideas of a correlator 
 

The FC correlator is a powerful device for the measurements of time-dependent correlation functions. 

The cross-correlation function G12 of two signals (light-scattering intensity, for example) I1(t) and I2(t) 

describes the similarity of the signals in the time domain. This function is defined as 

 

G12 () =  I1(t) I2(t+)  

 

where  is delay time and the angle brackets denote an average over the time t. The autocorrelation 

function describes the correlation between a signal and a delayed version of itself of a signal I1(t): 

G11 () =  I1(t) I1(t+)  

 

The correlator's algorithm consists of a multiplication of one signal with another that has been shifted 

(delayed) in time and then taking the integral of the product over time. 

 

The FC is designed for operation with the photon correlation spectroscopy (PCS) technique. Briefly, it 

can be explained as follows: the laser beam is scattered by the particles or macromolecules suspended 

in a liquid and undergoing Brownian motion. The scattered light spectrum is broadened due to the 

various phase shifts. The half width of the scattered light spectrum is given by the formula: 

 

 = Dq
2
 

 

where D is the linear diffusion coefficient of the Brownian particles and q is the modulus of the  

scattering wave vector. For a monodisperse suspension, the diffusion coefficient D is related to the 

particle hydrodynamic radius R by the Stokes-Einstein equation: 

 

D = kT / 6R 

 

where k is the Boltzman constant, T is the absolute temperature,  is the shear viscosity of the solvent. 

The autocorrelation function of the scattered-light field in a normalized form is 

 

g1() = e 
-t

 

 

The autocorrelation function of the light-scattering intensity is the fold of the Fourier transform of the 

spectrum with itself and has the normalized form: 

 

g2() = 1 + g1()
2
 = 1+ e 

-2t
 

 

The decay time is determined by the particle size. In the case of a mixture of particles with different 

sizes, one can obtain: 

 

g1() =  G()e 
-t

d 

 

The scattered light is received by a photodetector and the output signal of the detector is processed 

by the digital correlator to obtain the autocorrelation function. A computer calculates the mean size or 
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size distribution of the suspended particles from the autocorrelation function by inversion of the 

relation given above. 
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